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Important Information for the User
•

Changes or modifications not expressly approved by
Adaptive Instruments Corp may void the user’s authority to
operate the equipment.

•

This computer program is protected by copyright law and
international treaties. Unauthorized reproduction or
distribution of this program, or any portion of it, may result in
severe civil and criminal penalties, and will be prosecuted to
the maximum extent possible under law.

•

If the Wireless Instrumentation Manager (RF Server)
software is shutdown, the RS-485 network MUST be
physically disconnected from the PC as the serial port is
no longer being controlled by the software and may disrupt
communications between the Base Radio(s) and
Analog/Digital Output Module(s).
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1. Introduction
1.1. USING THIS MANUAL
This manual is designed to assist in installing, operating, and
maintaining Accutech Wireless Instrumentation Manager
software. Throughout the manual, Accutech Wireless
Instrumentation Manager software will be shortened to WIM. The
manual is broken into sections as follows:
Section 2: In a Hurry?
This section summarizes what must be done in order to get the
software installed, configured and in operation quickly. However,
it does not provide detailed or how-to information to perform the
tasks outlined.
Section 3: Installation
This section explains how to correctly
communications and run the software.

install,

set

up

Section 4: The RF Server
In order for WIM to constantly record data from Field Units and
make this information available to the users, a program called
RF Server needs to be running on the computer the Base Radio
Network is plugged into at all times. This computer will act as a
server to users who wish to log on to WIM and use the Client
software.
Section 5: Which Mode Should I Run?
WIM can be run in one of two modes: Configuration Mode or
Management Mode. This section will aid you in choosing the
mode which best fits your needs.
Section 6: Running the Client Software
Once you have set up and run the RF Server, the Client software
can be run from the computer on which the RF Server is running,
or the Client software can be run from a remote computer over a
Network (TCP/IP) connection.
Section 7: Formatting and Maintaining the Database
Data from Field Units is stored in databases on the Server. To
accommodate the different needs of different users, there are a
series of database options you should set.
Section 8: Understanding the User Interface
WIM has multiple “Views” in which you can monitor and
configure devices. This section will familiarize you with each of
these views.
Section 9: Device Monitoring, Configuration and Data
Exporting
This section explains how to monitor and configure devices. Also
covered in this section is the ability of WIM to export data in
various formats for use with other applications.
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1.2. ABOUT THE SOFTWARE
The Accutech Wireless Instrumentation Manager software is a
real-time network configuration and monitoring software
package. WIM allows you to quickly and accurately perform data
acquisition at a fraction of the cost of a wired system with a PLC
or DCS. In addition, WIM allows for the remote configuration of
Field Units and Output Devices that would normally be done at
the device level, saving time and money.
WIM also has exporting capabilities for analysis functions, which
give you bigger and faster returns on your wireless
instrumentation investments. This software can be used for long
term monitoring in remote locations, for short term data gathering
on process conditions, or to quickly test the economic viability of
a new installation.
The purpose of this Guide is to help you install and maintain
WIM.

1.3. UNPACKING
Remove the Packing List and check off the actual equipment
received. If you have any questions on your shipment, please
call your Accutech Representative. Upon receipt of shipment,
inspect the container for any signs of damage in transit.
Especially take note of any evidence of rough handling. Report
any apparent damage immediately to the shipping agent.
Please note that sometimes units are assembled with
accessories when shipped. Inspect the shipment carefully if you
think that something is missing. This is rare, as we take
considerable care to pack units for shipment, but it does
sometimes happen. Please give us a call and we may be able to
resolve this matter quickly over the phone.
Note Please note that the carrier will not honor any claims for
damage unless all shipping materials are saved for their
examination. If damage is found during examining and removal
of the contents, save the packing material and the carton.

1.4. SYSTEM REQUIRMENTS
Operating System Requirements:
• Windows® XP
Hardware Requirements:
• Processor: Recommend at least 1.0 GHZ
• Memory: 256 MB RAM or greater depending on the number of
Field Units being monitored
• Hard Disk Space: 150 MB for configuration, recommend 500
MB additional space if data collection is enabled
• Dedicated serial COM port, or USB port if using a SmartCable
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2. In a Hurry?
This section summarizes what must be done in order to get the
software installed, configured and in operation quickly. It does
not provide detailed or how-to information to perform the tasks
outlined.
[1]

Insert the WIM CD in the CD-ROM drive of the Host
computer.

[2]

Follow the installation instructions and install the software.

[3]

Run WIM by clicking the Accutech Wireless icon on the
desktop.

[4]

When prompted (when run for the first time only) select
Configuration Mode or Management Mode.

[5]

Connect to the RF Server, which is automatically launched
via the following settings in the connection view:
•
•
•
•

Local Computer
127.0.0.1
Admin
Password

[6]

Wait for WIM to discover all the devices on the network.

[7]

Each yellow device is an unconfigured device. Configure
these devices with appropriate settings and tag names.
Upon configuration these devices will turn green.

The following only applies if you chose Management Mode in
number four in the above list:
[1]

Set up user accounts and access levels via the Accounts
view.

[2]

Set up database management options via:
View→Server Options.

[3]

Exit the software and verify that the blue and red RF icon
remains running in the System Tray (lower right corner).
This must remain running at all times if you want to log
data into the database. It also must remain running if you
want to log on to the RF Server via a remote computer.

[4]

You must find the IP Address of the Host computer. Follow
the instructions below:
•
•
•
•
•

Click on the Start button
Select Run
Type “cmd”
Type “ipconfig” into the command line and press return
Record the IP Address, e.g. 192.168.1.66

The following applies if you are trying to log on to WIM via a
remote computer.
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Note You must have selected Management Mode in task four
above. If you did not select this mode go back to the Host
computer, run the software, and under:
View→Client Options select Management Tool.
[1]

Insert the WIM CD in the CD-ROM drive of the computer
(this is called the Client computer).

[2]

Follow the installation instructions and install the software.

[3]

Run WIM by clicking the Accutech Wireless icon on the
desktop.

[4]

Connect to the RF Server running on the Host computer
via the following settings in the connection view:
•
•
•

TCP/IP
Enter IP Address of Host computer, e.g. 192.168.1.66
Enter a User and Password of an account you set up

NOTE
Note If your Base Radio is not plugged into COM Port 1 of the
Host computer, then the user must right-click on the RF icon in
the system tray (lower right corner) and select Options. This will
allow the user to change the COM Port to the appropriate port
number.
Note The RF Server is run automatically (if it is not already
running) when the software is launched and a user connects.
If the software is run in Management Mode the RF Server will not
be shut down upon exiting the program as it must remain running
to collect data and allow users to login remotely.
To shut down the RF Server, right-click on the RF icon in the
system tray (lower right corner) and select Exit.
If the RF Server is shutdown, the RS-485 network MUST be
physically disconnected from the PC as the serial port is no
longer being controlled by the software and may disrupt
communications between the Base Radio(s) and Analog/Digital
Output Module(s).
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3. Installation
[1]

To begin installation place the WIM CD in the computer’s
CD-ROM drive.

[2]

The InstallShield Wizard should be displayed on the
monitor automatically as seen in Figure 3-1.

Figure 3-1: InstallShield Wizard
[3]

Once the InstallShield Wizard is up and running, Click
Next.

[4]

The following screen, shown in Figure 3-2, requires you to
accept the license agreement.

Figure 3-2: Software User Agreement Screen
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[5]

Select I accept the terms in the license agreement,
which indicates you have read and agree to the contents in
the Software Site License Agreement.

[6]

Click Next to move to the screen shown in Figure 3-3.

Figure 3-3: User and Organization Screen
[7]

Enter a User Name and Organization, and then click Next.

[8]

Now, click Install. The InstallShield Wizard will now install
the Accutech software on the computer. The install
process may take a few minutes.

[9]

After the installation is complete the screen in Figure 3-4
will be displayed.

Figure 3-4: Installation Path Screen
[10]

Click Finish to exit the InstallShield Wizard and complete
the installation.
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4. The RF Server
In order for WIM to constantly record data from the Field Units
and make this information available to you, a program called RF
Server needs to be running at all times on the computer which
the Base Radio is plugged into (the Host computer). This
computer will act as a Host to all users who log on via remote
computers.
Before starting the RF Server, here is a list of terms that you
should be familiar with:
RF Server– a program that runs on the Host computer which
stores all incoming data and provides this data to all the
Clients logged in.
Host computer– the PC or server which the Base Radio is
plugged into, and on which the RF Server is being run.
Client computer– any computer that is running WIM. The Client
computer can be the same computer as the Host computer.
Remote computer– a computer that is connected to the Host
computer via a TCP/IP network connection.
Local Computer– a connection type that is used when the Host
and Client are the same computer. This means that the Client
can find the RF Server “locally”, (i.e., the same computer).
TCP/IP– a connection type that is used when the Client
computer must use a network connection (e.g. an office intranet)
to connect to the RF Server running on the Host computer. This
connection requires knowledge of the Host’s IP Address.

4.1. Running the RF Server
If you have not done so already, install WIM. Then follow these
instructions to run the RF Server. From the Start menu, select:
Programs→Accutech Wireless Manager→Launch Server
Once you have done this, you will see the RF Server Icon in the
Windows System Tray (usually found in the lower right corner
like the one shown in Figure 4-1).

Figure 4-1: RF Server Icon
Because the RF Server is intended to run in the background and
constantly monitor and record data from the Base Radio through
the COM Port, it has a limited user interface that can be seen by
right-clicking the RF Server Icon (See Figure 4-2). To view the
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data being recorded the user can log on using the Client
program (See Section 6 for more details).

Figure 4-2: RF Server Menu
The Base Radio should be plugged into an available COM Port
on the computer at this time. If you are using a SmartCable, a
USB port may be used. Right-click the RF Sever icon and select
Options to configure the appropriate Port. The default is COM
Port 1. In order for WIM to receive data from the Base Radio, the
RF Server must be running on the Host computer. If this is not
the case no data will be recorded, and you will not be able to
connect and run any Clients from remote computers or the local
computer.
If you wish to shut the RF Server application down, right-click on
the RF Server icon and select Exit. Note that you must restart
the RF Server on the Host computer in order to receive data and
run the Client software. Also, the RS-485 network MUST be
physically disconnected from the PC as the serial port is no
longer being controlled by the software.
In order to allow the Client software to find the RF Server, you
must also specify where the RF Server is located. If the Client
and Host are the same computer the connection type is Local
Computer. If the Client is a remote computer the connection type
is TCP/IP and the IP Address of the Host computer must be
specified.
To find the IP Address of the Host computer follow these
instructions:
•
•
•
•
•

Click the Start button
Select Run
Enter “cmd”
Enter “ipconfig” into the command line and press return
Record the IP Address, e.g. 192.168.1.66

Useful Definitions
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Note The RF Server program must remain running to collect
data and allow users to login remotely.
If the RF Server is not running on the Host computer, users will
not be able to log in.
Also, a single user account cannot be logged on to the RF
Server from more than one computer at a time.

NOTE
4.2. Additional RF Server Functions
The following functions are also available from the RF Server
menu (See Figure 4-2).
About – Contains the software version number.
Reset Passwords – Resets the Admin password to password
and deletes all of the other user accounts.
Reset Database – Resets the database to the default values.
This will also delete all logged Field Unit data.
Compact Database – Runs a Microsoft Access function to
compact the database. Use this to help save hard disk space if
your database is getting large.
Discover Devices – Searches for any new devices that have
been added to the Wireless Network. It is recommended to run
Discover Devices after adding any new devices.
Delete Field Units – Removes a Field Unit from WIM Client and
from the Configuration database. Wait at least two minutes after
disconnecting the Field Unit before deleting the Field Unit from
WIM. This allows the Base Radio to acknowledge the missing
Field Unit. Any previously collected data from that Field Unit is
NOT deleted. However this data is not accessible from WIM and
may only be viewed from the Access Database
Options – Opens the RF Manager Service Configuration dialog
box. This is used to configure a port.
Restart Server – Stops and restarts RF Server.
Exit – Stops RF Server.
Note If you experience mouse issues, unplug and plug in the
Base Radio. Also do not leave the Base Radio plugged in while
rebooting the computer as this will cause the PC to recognize the
Base Radio as a mouse and move the pointer erratically. Instead
wait until you are ready to run the software.

9
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5. Which Mode Should I Run?
WIM can be run in one of two modes:
•
•

Configuration Tool mode
Management Tool mode

This section will aid you in choosing the mode which best fits
your needs.
These modes are called Client Options. When WIM is run for the
first time you are asked to make this decision. However, you can
change this setting at any time by selecting Client Options from
the View menu at the top of the program window.

5.1. Management Mode
The Management Tool setting should be used when the user
wishes to only monitor and configure a single Wireless
Instrumentation network. In Management Mode:
•
•
•
•
•
•

Data is stored in the database and NOT deleted when
RF Server is shut down (Sec. 7)
Multiple users can log in from remote computers (Sec.
6)
User accounts and security levels can be created
(Sec. 8)
User can connect via Local Computer and TCP/IP
(Sec. 6)
Requires user to manage database size and settings
(Sec. 7)
RF Server remains running when Client is closed (Sec.
4)

Another important distinction is that unlike Configuration Mode,
the Management Mode saves all the configuration data for the
Output Modules and reconfigures these devices every time the
RF Server is launched. Thus if a different Wireless
Instrumentation network is plugged into the Host computer the
old configuration data will be uploaded to the different devices
that share that same ID’s as the old devices, which may cause
outputs to be different than what is expected.
This issue can be mitigated by using separate Host computers or
by running in Configuration Tool Mode.
Note Once WIM is connected to a wireless network and WIM is
in Management Mode, certain Field Unit menus will no longer be
locally accessible via the Next and Enter buttons. This is done to
prevent Field Unit settings from being changed without the
Administrator’s knowledge.
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5.2. Configuration Mode
The Configuration Tool setting should be used when the user
wishes to plug into existing networks, (or move from network to
network) in order to configure units without retaining the
gathered data that is accumulated while the RF Server is
running. In Configuration Mode:
•
•
•
•
•
•

Data is stored in the database and DELETED when
RF Server or the Client software is shut down (Sec. 7)
Users CANNOT log in from remote computers (Sec. 6)
User accounts CANNOT be created (Sec. 8)
User can connect via Local Computer only (Sec. 3)
User does not need to manage the database size (Sec. 7)
RF Server is shut down when the Client software is shut
down (Sec. 4)

Another important distinction is that, unlike the Management
Mode, the Configuration Mode does not save all the
configuration data for the network. In this mode the software
simply gathers as much configuration information from the
network as it can. When configuration changes are made to any
of the devices via the software, these changes are downloaded
to the devices and preserved.
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6. Running the Client Software
The WIM client software is the application that is used to connect
to the RF Server in order to configure and monitor devices. This
software can be run on the RF Server Host computer or it can be
run on a remote computer and connected to the RF Server via a
TCP/IP connection. Both cases are covered in this section.
Once you have installed the software, the WIM Client icon
appears on the desktop. It is labeled Accutech Wireless:

Figure 6-1: WIM Client Desktop Icon
Double-click the WIM Client icon to start WIM. WIM can also be
started through the Start menu:
Programs→Accutech Wireless Manager→Accutech Wireless
Once the Client software has been started, the Connection View
will be displayed. This view is shown in Figure 6-2.

Figure 6-2: The Connection View
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6.1. Local Computer Connection
WIM has two Client connection options. The first is Local
Computer Mode. This mode should be used when running the
Client on the same computer on which the RF Server is running.
(See Section 4 for more details)
Since the Client can find the RF Server on the same computer
from which it is being run, it is said that the RF Server is being
run “locally” or on the same computer. This type of connection
does not require an IP Address to be specified. A Local
connection is performed as follows:
•
•
•
•

Connection: Local Computer
Server: N/A
User: Admin
Password: password

Note If you have selected to run in Configuration Tool Mode then
the connection type is limited to Local Computer. (See Section 5
for more details.)

6.2. TCP/IP Connection
The second Client connection option is the TCP/IP Mode. This
mode should be used when the RF Server is being run on a
different computer and the user wishes to log in via a network
connection on their computer.
Since the Client must find the RF Server via a network, the Client
must be given an IP Address where the RF Server can be found.
(To find the Host computers IP Address, see Section 3.) This
type of connection is called a TCP/IP connection. A TCP/IP
connection is performed as follows:
•
•
•
•

Connection: TCP/IP
Server: 192.168.1.88 (for example)
User: Admin or any created user account
Password: password

Note If the RF Server is not running on the Host computer, you
will not be able to log in. Also, a single user account cannot be
logged into the RF Server on more than one computer at a time.
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7. Formatting and Maintaining the
Database
Every transmitted sample of every Field Unit is logged into a
Microsoft Access database through WIM. Because the number
of Field Units and frequency of data transmission varies with
each Wireless Instruments installation, the rate at which this
database grows also varies. To accommodate the different
needs of different users, there is a series of database options
that should be set.
To configure these options, select Server Options from the
View menu. The following dialog box appears:

Figure 7-1: Database Storage Options
The settings shown in Figure 7-1 are the default settings of the
data storage options. The Save Data check-box allows the user
to enable or disable the saving of incoming Field Unit data in the
database.
If you do not want to export data, generate reports, save device
configuration data, or see graphs of past Field Unit values, clear
the Save Data check box. Doing so will still allow the user to
monitor alarms and real-time streaming data. No Field Unit
history will be kept.
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If you want to see past Field Unit data graphs or export data,
select the check box to save the incoming data. Note that this
will use a greater amount of hard drive space depending on the
resolution options you have selected.
If you have chosen to save data then you should also set the
high and low resolution data settings according to your demands.
A description of the function of each setting is located below the
settings.
•
•

High resolution data consists of a data point for every
transmitted value by every Field Unit and is stored in
FieldUnitRawData.mdb.
Low resolution data consists of one minute’s worth of
data points averaged to one data point for each Field
Unit and is stored in FieldUnitData.mdb.

If you wish to preserve the database beyond the 90-day low
resolution data limit, you must make a copy of the low resolution
database file. This file, FieldUnitData.mdb, is installed in the
following directory: AccutechWirelessManager\Database. You
can copy and paste the database in any folder you choose. It is
suggested you rename the saved database with the date range,
(e.g., Jan-Feb 2005).
If you run out of hard drive space due to the size of the database
you may have to reduce the length of time that the low resolution
data is retained. Doing so will reduce the size of the database.
Note If you have opted to run WIM in Configuration Tool Mode,
the database will only store data while the Client software and
RF Server are running. Upon closing these programs, all saved
configuration and sample data will be deleted.
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8. Understanding the User Interface
Once you have connected the software to the RF Server
(Sections 4 and 6), you are able to view different types (or views)
of data. These include the Connection, Field Units, Base &
Output Devices, Tasks, and Accounts views. To select these
views click, on their respective icons in the Views pane located
on the left hand side of the Client program. The Events and Chat
Log appears in every view and is covered in Section 8.5.
The following sections will step through each of these views and
describe their functionality and features. The section outline is as
follows:
8.1: The Field Unit View
8.1.1: The Overall Field Units’ Conditions
8.1.2: The Selected Field Unit Condition
8.1.3: The Field Units Pane
8.1.4: The Field Unit Group Tree

8.2: The Base & Output Devices View
8.3: The Tasks View
8.4: The Accounts View

8.1. The Field Unit View
The view you will see upon connection is the Field Unit View.
This view shows the Field Unit information, and allows you to
configure and view individual Field Unit data. This view can be
accessed at any time by clicking on the Field Units icon in the
Views pane. The Field Unit View is shown in Figure 8-1.

1
4
2

3

Figure 8-1: Field Unit View
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Each of the four numbered areas in Figure 8-1 is explained in the
following sections in order.
8.1.1. #1 - The Overall Field Units’ Conditions
The Overall Field Units Conditions box refers to all Field Units
that are on the network. This box tells the user the total number
of Field Units there are, how many Field Units are in an alarm
condition (red), and how many Field Units are in a warning
condition (yellow or orange).
Note The installation and configuration of the individual Field
Units via WIM is covered in the respective Field Unit User
Manuals. Please see these manuals for more specific details
regarding these devices.
8.1.2. #2 - The Selected Field Unit Condition
The Selected Field Unit Conditions box is different from the
Overall Field Unit Conditions box, in that the Selected Field Unit
shows only the condition of the Field Unit that is selected in the
Field Units Pane. This box shows the Field Unit type and the
current condition:
•
•
•
•

Green - All systems are configured and OK. No
Alarms
Yellow - The Field Unit is un-configured
Orange - There is a system warning with the Field Unit
Red - An Alarm is being exceeded

8.1.3. #3 - The Field Units Pane
The Field Units Pane shows all the Field Units in the selected
group from the Field Units Group Tree (#4). Each Field Unit in
this pane has a color that indicates its current condition (see
above for color description). In addition, the following information
is displayed: Tag Name, Monitored Equipment, ID (See Note),
Device Type, Status of the Field Unit, and the current Primary
and Secondary Values that the Field Unit is reading. (For more
information on how to configure and monitor individual Field
Units see Section 9).

NOTE
Note Field Units are often referenced throughout the software by
two numbers, such as 1-1 in Figure 8-1. The first number refers
to the Base Radio ID and the second number refers to the Field
Unit RF ID.
8.1.4. #4 - The Field Units Group Tree
The Field Unit Group Tree allows the user to select and group
which Field Units are displayed in the Field Units Pane (#3).
•

17

All Field Units view is the default view and displays a
scrollable list of every Field Unit that has been
discovered on the network.
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•

Alarming Field Units view displays only Field Units
that are in an alarm condition (discussed in the Field
Unit Configuring and Monitoring section).

•

Unconfigured Field Units view displays Field Units
which have been discovered on the network, but have
not been renamed or configured.

•

Field Unit Groups view allows the user to assign
Field Units to individual groups, and then view the
Field Units by those groups. Groups are added by right
clicking on the Field Unit Groups folder and selecting
Add Child Group. Deleting and Renaming of groups is
done in the same fashion. To add Field Units to a
group, click the desired Field Unit and drag and drop it
to the appropriate group folder.

•

Base Radios view displays the Field Units that are
associated with the selected Base Radio.

•

Field Unit Types view displays each set of Field Units
on the network by type, e.g. Acoustic Field Unit.

8.2. The Base & Output Devices View
This view shows the Base Radio and optional Analog/Digital
Output Devices. This view can be accessed at any time by
clicking on the Base & Output Devices Icon in the Views pane.
The Base & Output Devices View is shown in Figure 8-2.

Figure 8-2: The Base & Output Devices View
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The Base & Output Devices view allows you to rename and view
data about each of your Base Radios as well as any optional
Analog/Digital Output Modules you have installed on the RS-485
network (see the Analog/Digital Output Module User Manual for
more information on installation on configuring this device).
The RF Channel and Number of Field Units communicating with
each Base Radio are listed under the Base Radio pane. ID and
output Device Type are listed for each Analog/Digital Output
Module under the Output Device pane.
Note If you have added a new device such as Field Unit or
Analog/Digital Output Module to an existing wireless network the
device may not show up automatically in the Client software. To
force the program to search for new devices click Discover
Devices under the File menu.

NOTE

8.3. The Tasks View
The Tasks view shows the scheduled tasks that need to take
place, such as configuration information to be uploaded to the
Field Units. This view can be accessed at any time by clicking on
the Tasks icon in the Views Pane.

Figure 8-3: The Tasks View
The importance of the Tasks view is to let the user know when
the configuration changes made to the Field Unit have been
successfully downloaded to the Field Unit. Thus, the user cannot
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expect to see the configuration changes at the unit until the task
is completed.

8.4. The Accounts View
The Accounts View allows management of all the user accounts.
This view can be accessed at any time by clicking on the
Accounts Icon in the Views Pane. However, only those with
Administrative Access can make changes in this view. The
Accounts View is shown in Figure 8-4:

Figure 8-4: The Accounts View
This view allows the addition, deletion, and editing of user
accounts to the software. Clicking Add allows the user to add a
new user account. When adding a new account a name,
password, and level of access must be given.
There are three levels of access that can be granted to a user:
•
•
•

Administrative – able to make changes to anything.
Read/Write – able to view data and change Field
Units and Base Radio outputs and thresholds.
Read Only – able only to view the collected Field Unit
data and the current configurations. Not allowed to
make changes.

User accounts can be deleted by selecting the user account in
the left-hand column and clicking the Remove button. User
access levels and passwords can also be changed by selecting
the user account in the left hand column and clicking the Update
button.
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NOTE
Note If security is an issue, the Admin (or manager of the
Wireless Network) should log in under the Admin account and
setup new accounts for all users. The Admin account should
then be deleted.
WIM security, much like many programs, is only as good as the
Host computers security. If security is an extreme issue then the
Host computer should be accessible to the Admin only.

8.5. The Events and Chat Log
At the bottom of every view the Events or Chat Log is displayed.
The view of either of these is toggled by clicking either of the
labeled tabs in the lower left hand corner of the Client software.
The Events Log records the last 50 changes that were made to
the network (e.g. addition of new Field Unit, changing of Field
Unit status). Each of these events is logged with a description,
as well as a time and date stamp. The Events Log is shown in
Figure 8-5:

Figure 8-5: Events Log
The Chat Log allows the user to chat with all users on the
network and see which users are currently logged into the RF
Server via the Client program. The chat log works by posting a
message to the user and allowing them to reply, much like an
instant messenger service. To type a message, click in the
bottom frame and type. Press Enter to send the message. The
Chat Log is shown in Figure 8-6:

Figure 8-6: Chat Log
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9. Device Monitoring, Configuration and
Data Exporting
Each device has its own monitoring, configuration and data
exporting capability within WIM. The purpose of this section is to
give the user an overview of how to use these capabilities.
The following sections will step through each of these
capabilities and describe their functionality and features. The
section outline is as follows:
9.1: Monitoring a Field Unit
9.1.1: Field Unit Data Graphs
9.1.2: Software Alarm Thresholds
9.1.3: Field Unit State
9.1.4: Field Unit Primary & Secondary Values

9.2: Configuring a Field Unit
9.3: Exporting Field Unit Data

9.1. Monitoring a Field Unit
Each Field Unit has its own monitoring capabilities, which can be
accessed through the Field Unit view. See Section 8.1 for more
details on the Field Unit view.
When in the Field Unit view, double-clicking (or right-clicking and
selecting View Field Unit Data) on a particular Field Unit’s icon
will bring up that Field Unit’s Status Window as shown in Figure
9-1. The data and fields will differ based on the type of Field Unit
that is selected. The screen shot in Figure 9-1 shows data for an
Acoustic Field Unit.
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Figure 9-1: Field Unit Status View
The figure above has been numbered from one to four. Each of
the following subsections will cover these areas of the Field Unit
Status view.
9.1.1. #1 - Field Unit Data Graphs
The Field Unit data graphs show the current and all past data
that is available in the Field Unit database. The upper graph is
the Primary process variable (shown as Ultrasound in Figure 91), and the lower graph is the Secondary process variable
(shown as Temperature in Figure 9-1). All process value points
are shown in blue if they are within a user selected alarm
threshold (indicated by a red line). Any data points exceeding an
alarm threshold appear in red. These alarms can be set in the
Field Unit Configuration menus under the Alarms tab.
The Y-axis resolution of the data graphs may be changed in the
Field Unit Configuration menus under the Range tab.
The data graphs can be panned and zoomed via the control
buttons located below the graphs. The graphs can also be
specified to show a user selectable data range by using the
Specify Range button.
If at any time you would like to see the most current data simply
click the Show Current Data button.

NOTE
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Note If the save data option for the database is disabled the
graphs will not show any data. (See Section 7 for more details on
database management).
Any missing data on the graphs will appear as a gray area. If the
user has selected to run the software in Configuration Mode,
only data gathered during the current run of the software will be
displayed, as all database data is deleted when the software is
shut down in this mode. (See Section 5 for more details).

9.1.2. #2 - Software Alarm Thresholds
The Alarm Thresholds refer to alarm set points that have been
set in the WIM Field Unit Configuration menu to warn the user
of important changes in the Primary and Secondary process
values. There are 4 alarm thresholds available for a single
process variable unit, and there are 2 alarm thresholds available
for each process in a dual process variable unit. The alarm
thresholds are set in the Field Unit Configuration menu under
the Alarms tab.

NOTE
Note The software alarms exist only within the Client software.
These alarm thresholds are NOT downloaded into any devices,
thus these alarms are not displayed on the Field Unit LCD’s.
The purpose of these alarms is to notify a user looking at the
Client software when possible alarm conditions occur.
9.1.3. #3 - Field Unit State
The Field Unit State box gives the user the time of the last
update received from the Field Unit. All other information
contained within the State box is specific to the time of the last
update time.
The green “OK” message will change to a red exclamation point
if the respective status reading is in concern or if either of the
process values is above an alarm threshold.
9.1.4. #4 - Field Unit Primary & Secondary Values
The current Field Unit primary and secondary values are shown
via graph levels in blue. If a process variable were exceeding a
user set alarm threshold, the graph level would appear in red.

9.2. Configuring a Field Unit
WIM allows for the configuring of Field Unit settings that would
normally be done using the Next and Enter buttons on the
individual Field Unit. These changes are done via the
Configuration menu.
The Configuration menus are displayed by clicking on the
Configure button in the Field Unit’s Status View (See Figure 91) or by right clicking on the Field Unit icon within the Field Unit
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View and selecting Configure. Doing so will bring up the
Configure Menu.
Because each Field Unit has different configuration options
available, the directions on how to configure a particular Field
Unit are located within the respective Field Unit’s User Guide.
Please see the individual Field Unit User Guides for more details
on how to configure these devices using the WIM.

NOTE
Note Once WIM is connected to a wireless network and WIM is
in Management Mode, certain Field Unit menus will no longer be
locally accessible via the Next and Enter buttons. This is done to
prevent Field Unit settings from being changed without the
Administrator’s knowledge. (See Section 5 for more details on
the Management Mode setting).

9.3. Exporting Field Unit Data
The export function allows you to export Field Unit data from the
database to a separate file for use with different data analysis
tools. You can export data in comma separated value (.CSV) or
text (.TXT) formats.
To export data for a Field Unit, click on the Exports button in the
Field Unit’s Status View (See Figure 9-1) Doing so will bring up
the export wizard as shown in Figure 9-2:

Figure 9-2: The Data Export Wizard
Upon entering the Export Data Wizard, the user is prompted to
select the fields of data to be exported. To select a field, highlight
the field in the left-hand column and click the right-pointing
arrow. To remove a field from the export list, highlight that
desired field and click the left-pointing arrow.
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After selecting the fields to be exported, click Next. Then you are
prompted to enter the date range for the data, in Figure 9-3.

Figure 9-3: The Data Export Wizard – Data Range
After entering the data range, click Next. Finally, you are asked
to select an export file type and enter a file name, in Figure 9-4.

Figure 9-4: The Data Export Wizard – Output File
Click Start to begin the data export.
Note The export option is only available if the data save option
for the database has been enabled (see Section 7 for more
details on database management).
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ABOUT US

.

Accutech, a division of Adaptive Instruments Corp., is a leading edge,
technology-driven developer, manufacturer and supplier of embedded
microprocessor-based electronics. Based in Hudson, Massachusetts,
Accutech is the most successful leading independent producer of
wireless instrumentation on the market today.
Accutech customers include large national companies in the oil and gas,
chemicals, pharmaceutical, food and beverage, primary materials
processing, and energy industries. In addition to the wireless product
line, Accutech also offers a traditional wired line of temperature, pressure
and differential pressure instrumentation.
In the process control field, where quality is taken for granted and new
technology is announced daily, we have deliberately concentrated our
efforts on the development of instrumentation that makes business
sense. The result is a product range that is rugged, secure, and reliable
and works in even the most hazardous environments. We give
companies the tools to reduce costs, save time, enhance safety, improve
environmental performance and cut waste.
The next industrial revolution is right now. Let Accutech show you how to
realize gains in operating efficiency.

Visit us at: www.accutechinstruments.com
Or call us at +1 800 879-6576
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